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Overview 
Stellar Phoenix Word Recovery is designed to recover corrupted Microsoft Word (.DOC) files. 
This software scans all selected Word documents and uses an advanced algorithm to restore 
Word files back to their original state. The recovered files can either be saved to their original 
location on the hard disk, or to any user-specified location. 

You can preview the Word files in three different modes - Full document, plain text and raw text. 
Full document is same as opening a Word file in Microsoft Word. Plain text shows only the text of 
the Word file without formatting and other attributes of the document. Raw text is machine-
readable format. 

You can search for Word files in folders and drives. You can save all or individual files. In 
addition, you can save files to original location or specific location. 

Key Features of Stellar Phoenix Word Recovery 

• Recovers text and preserves formatting of original document 

• Recovers tables, bulleted lists, embedded images, and other attributes of Word files 

• Restores header and footer 

• Preview of files available in demo version and full version 

• Supports Word 2000, XP(2002), 2003 and 2007 

• Compatible with Windows NT/ 2000/ XP/ 2003/ Vista 
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Getting Started 
Word Recovery software provides you preview, search and recover options for performing 
recovery of Word documents. The user interface of Word Recovery software is easy to use and 
anyone can use it without any technical knowledge. You can start recovering Microsoft Word files 
after installing the iPod Recovery software. 

 Installing Word Recovery software 

 Order and Register 

 Main User Interface 

 Toolbar 

 Menubar 



Installation Procedure 

3 
Help Manual Version 3.1.0.0 

 
 

Installation Procedure 
Before installing the software, ensure that your computer meets the minimum system 
requirements to install Stellar Phoenix Word Recovery software. 

• Minimum System Requirements 

Processor :Pentium Class 

Operating System: Windows NT / 2000 / XP / Vista 

Memory :128 MB recommended 

Hard Disk :10 MB of free space 

MS Word: 2000 / 2002 (XP) / 2003 / 2007 

To install the software: 

1. Double-click swr.exe file to open the Stellar Phoenix Word Recovery Setup Wizard. Click 
Next. 

2. On the Specify Destination Location screen, specify the destination where Stellar 
Phoenix Word Recovery software should be installed. Click Next. 

3. On the Select Start Menu Folder screen, specify the destination where program shortcuts 
should be stored. Click Next. 

4. On the Select Additional Tasks screen, check the checkboxes of required icons. Click 
Next. 

5. On the Ready to Install screen, click Install. 

6. Click Finish to exit setup wizard. 
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Order and Register 
You can purchase the software online. For price details and to place the order, click here. 

On confirmation of order, a pre-paid serial number is sent to you through e-mail that would be 
required to register the software. 

Register Stellar Phoenix Word Recovery: 

After receiving the Registration Key, the software can be activated. 

To register the software: 

• Method 1 

1. Click Enter Key button on the reminder window. 

2. Type the name and key (received through e-mail after purchase). 

3. Confirmation message pops up, if the key is valid, click OK. 

• Method 2 

1. Run demo version. 

2. On the Tools menu, Click Activate. 

3. Type Name and Key. Click OK. 
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User Interface 
The main user interface of Stellar Phoenix Word Recovery is as shown below. 
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Toolbar 
Toolbar of Stellar Phoenix Word Recovery consists of the given below tools: 

• Add file to tree view 

  

Opens Stellar Phoenix Word Recovery box, which allows you to select Microsoft Word files from 
folders and volumes. In addition, you can search files by using this dialog box. 

• Remove File(s) /Folder(s) from tree view 

 

Removes files that are checked from the tree 

• Start Repair  

 

Starts recovering files 

• Advance Repair 

 

Processes advance repair of selected files 

• Stop 

 

Stops an ongoing repairing process 
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• Stellar Phoenix Word Recovery Help 

 

Opens help manual of the software 

• Updates 

 

Download latest updates of the software 

• Purchase 

 

Shows links from where you can buy the software   

• About Stellar Phoenix Word Recovery 

 

Shows general information about the software 
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Menubar 
These are the menus and items in the Stellar Phoenix Word Recovery software. 

• File 

o Add File to Tree View: to add Word files to the tree view 

o Remove from Tree: to remove selected files from the tree view 

o Start Repair: to start the repairing process 

o Advanced Repair: to repair the corrupted files 

o Stop: stop a process 

o Exit: to quit the application 

• View 

o Toolbar: Show/Hide the toolbar 

o Status bar: Show/Hide the Status bar 

o Message bar: Show/Hide the Message bar 

• Tools 

o Save Log: To save the log information 

o Clear Log: To clear the log information 

• Help 

o Stellar Phoenix Word Recovery help: Opens the user guide 

o Purchase Stellar Phoenix Word Recovery Online: Purchase details of the product 

o Activate Stellar Phoenix Word Recovery: Purchase details of the product 

o View support section: Opens Stellar support section webpage 

o Visit knowledge base: Opens knowledge base article webpage 

o Submit support ticket: Opens the login page, to submit ticket 
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o Updates: To open update wizard for live updates 

o About Stellar Phoenix Word Recovery: Generic information about the product 
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Using the Software 
Stellar Phoenix Word Recovery software repairs and restores MS Word (.doc) files corrupted due 
to virus attack, software malfunctioning or unexpected system shut down. It can recover single or 
individual Word files. 

o Repairing Word files 

o Adding files 

o Searching files 

o Viewing preview 

o Viewing log 
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Repairing Word Files 
Stellar Phoenix Word Recovery recovers Microsoft Word files and allows you to save to your 
preferred location. You can recover individual or multiple files by using Word Recovery. In 
addition, you can save Word files as original Word document, as plain text, or in machine-
readable format. 

To recover Microsoft Word files: 

1. Click  icon or on the File menu, select Add file to tree view. 

2. In the Stellar Phoenix Word Recovery box, add files by using one of the following: 

• Select individual file 

o Click Select File to add individual Word file. In the Open dialog box, 
locate and select the Word file. Click Open. 

• Select multiple files 

1. Click Select Folder to add multiple files. In the Browse for Folder dialog 
box, browse and select the required Folder. You can also select a 
volume. Select folder or volume. Click OK, and then click Add.  

2. In the Stellar Phoenix Word Recovery dialog box, all files that are found 
in the selected folder or drive are listed. Check the checkboxes of files 
that needs to be recovered. Click Add. All files will be listed in the left 
pane under Stellar Phoenix Word Recovery node. 

• Search files 

o Click Search File(s). In the Select Drive box, select a drive from Look in 
listbox. Click Start. All files that are found are listed in the Stellar Phoenix 
Word Recovery box. In addition, you can search in folder, click Search 
in Folder. In the Browse for Folder dialog box, locate and select a folder. 
You can also specify a drive. Select a folder or volume. Click OK. Check 
Search in Subfolders checkbox if you want to search files inside the 
subfolders also. Click Start. All files that are found are listed in the Stellar 
Phoenix Word Recovery box. 

3. All selected files are listed in the left pane. Check the checkboxes of files that needs to be 
covered. Select either: 

• Start Repair: Click Start Repair icon. In the Save Document dialog box, select 
Default location of file or Select New Folder. Former will save the file to its 
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original location from where it is added. Latter allows you to specify new 
destination. In the Save As box, select the format in which document should be 
saved - Full Document, Filtered Text, or Raw Text. Click OK. 

• Advance Repair: Click Advance Repair icon. In the Save Document dialog box, 
select Default location of file or Select New Folder. Former will save the file to 
its original location from where it is added. Latter allows you to specify new 
destination. 

4. Click OK after selecting one of the option given in the earlier step. All selected files are 
saved at the specified location. 

Note: You can also select Preview, Start Repair and Advance Repair option by 
right-clicking a file under the tree. 
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Adding Files 
You can add individual files or multiple files in the Word Recovery software. In addition, you can 
specify a folder or a volume as a folder such that all Word files can be added from that folder. 

To add individual file: 

1. Click Add File to Tree View icon on the toolbar, or on File menu, select Add File to 
Tree View. 

2. In the Stellar Phoenix Word Recovery dialog box, click Select File.  

3. In the Open dialog box, locate and select the required Word file. Click Open, and then 
click Add. 

To add multiple files: 

1. Click Add File to Tree View icon on the toolbar, or on File menu, select Add File to 
Tree View. 

2. In the Stellar Phoenix Word Recovery dialog box, click Select Folder.  

3. In the Browse for Folder dialog box, browse and select the required Folder. You can also 
select a volume. Select folder or volume. Click OK, and then click Add. 

4. In the Stellar Phoenix Word Recovery dialog box, all files that are found in the selected 
folder or drive are listed. Check the checkboxes of files that needs to be recovered. Click 
Add. All files will be listed in the left pane under Stellar Phoenix Word Recovery node. 
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Searching Files 
You can search for Microsoft Word files in your computer by using search option of the software. 
In case, you are unaware of the exact location of required file you can search the file easily. 

To search files from drive: 

1. Click  icon. In the Stellar Phoenix Word Recovery dialog box, click Search File(s). 

2. In the Select Drive box, select a drive from Look in listbox. Click Start. All files that are 
found are listed in the Stellar Phoenix Word Recovery box. 

To search files from folder: 

1. Click  icon. In the Stellar Phoenix Word Recovery dialog box, click Search File(s). 

2. In the Select Drive box, click Search in Folder. 

3. In the Browse for Folder dialog box, locate and select a folder. You can also specify a 
drive. Select a folder or volume. Click OK. Check Search in Subfolders checkbox if you 
want to search files inside the subfolders also. 

4. Click Start. All files that are found are listed in the Stellar Phoenix Word Recovery box. 
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Viewing Preview 
Stellar Phoenix Word Recovery shows preview of corrupted Word files that helps you to evaluate 
files before repairing. You can view the content of files in three different formats – Full document, 
Filtered text and Raw text. These file previews are available according to the condition of the file 
damage. In case of severely damaged files, the software provide plain text preview of the file 
content in Filtered text and Raw text view. If you want to preview a file, double click on the 
required file in the tree view. 

To preview the file: 

• Double-click on file in the left pane or right click and select Preview, which shows the 
preview of file. Click Filtered Text tab or Raw Text tab, in the middle-box of main user 
interface, to preview files in plain text or machine-readable form respectively. 

• Full document 

This will show exact preview of word document as the document is opened in Microsoft Word. It 
shows all formatting, embedded images, text formatting, hyperlinks and other attributes of document. 
In some cases, you are unable to view the corrupted file in this format. 

 

• Filtered Text 

This shows the content of documents in plain text. Click Filtered Text tab to view this format. 
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• Raw Text 

This shows machine-readable text. Preview in raw format is available in any case, even for a 
severely corrupted files or files with unsupported formats. Click Raw Text tab to view this format. 
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Removing Files 
You can remove files from the Stellar Phoenix Word Recovery node. If some files are added that 
are not required then you can remove these files without exiting the Word Recovery software. 

To remove files: 

1. Check the checkboxes of file that needs to be removed. 

2. Click  icon from toolbar or on the File menu, select Remove from Tree. All selected 
files will be removed. 

Note: By default, all files are checked when you add files in the tree. If you click 
Remove files from tree icon all files will be removed. Therefore, ensure that you 
checked or cleared the checkboxes of required file. 
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Log Report 
Log window shows the progress of the current process. The log window displays messages such 
as indicating the beginning of the process, end of the process, name of the corrupted file. 

• To enable log window 

o On the View menu, select Message log 

• To save log information 

o On the Tools menu, select Save Log. In the Save As dialog box, specify the 
destination where log file should be saved. Click Save. 

• To clear log information 

o On the Tools menu, select Clear Log. 
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Copyright 
Stellar Phoenix Word Recovery software, accompanied user manual and documentation are 
copyright of Stellar Information Systems Ltd., with all rights reserved. Under the copyright laws, 
this user manual cannot be reproduced in any form without the prior written permission of Stellar 
Information Systems Ltd. No Patent Liability is assumed, however, with respect to the use of the 
information contained herein. 

Copyright © 1995-2009 by Stellar Information Systems Ltd. INDIA 
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Disclaimer 
The Information contained in this manual, including but not limited to any product specifications, 
is subject to change without notice. 

STELLAR INFORMATION SYSTEMS LTD PROVIDES NO WARRANTY WITH REGARD TO 
THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 
EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR 
FITNESS FOR ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING 
STELLAR INFORMATION SYSTEMS LTD ASSUMES NO LIABILITY FOR ANY DAMAGES 
INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL 
ERRORS OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE 
PRODUCT AND THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION SYSTEMS 
LTD, BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY 
DAMAGES, WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF 
OR IN CONNECTION WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED 
HEREIN OR THE USE THEREOF. 
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Trademarks 
Stellar Phoenix Word Recovery® is a registered trademark of Stellar Information Systems Ltd. 

Windows 2000®, 2003®, XP® and Windows Vista® are registered trademarks of Microsoft® 
Corporation Inc. 

All Trademarks Acknowledged. 

All other brands and product names are trademarks or registered trademarks of their respective 
companies. 
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License Agreement 
Stellar Phoenix Word Recovery 

Copyright © 1995-2009 by Stellar Information Systems Ltd. INDIA 

www.stellarinfo.com 

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar Phoenix Word Recovery. 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing 
this software, unless you have a different license agreement signed by Stellar Information 
Systems Ltd. 

If you do not agree to all of the terms and conditions of this License then do not copy, install, 
distribute or use any copy of Stellar Phoenix Word Recovery with which this License is included, 
you may return the complete package unused without requesting an activation key within 30 days 
after purchase for a full refund of your payment. 

The terms and conditions of this License describe the permitted use and users of each Licensed 
Copy of Stellar Phoenix Word Recovery. For purposes of this License, if you have a valid single-
user license, you have the right to use a single Licensed Copy of Stellar Phoenix Word Recovery. 
If you or your organization has a valid multi-user license, then you or your organization has the 
right to use up to a number of Licensed Copies of Stellar Phoenix Word Recovery equal to the 
number of copies indicated in the documents issued by Stellar when granting the license. 

Scope of License 

Each Licensed Copy of Stellar Phoenix Word Recovery may either be used by a single person or 
used non-simultaneously by multiple people who use the software personally installed on a single 
workstation. This is not a concurrent use license. 

All rights of any kind in Stellar Phoenix Word Recovery, which are not expressly granted in this 
license, are entirely and exclusively reserved to and by Stellar Information Systems Ltd. You may 
not rent, lease, modify, translate, reverse engineer, decompile, disassemble or create derivative 
works based on Stellar Phoenix Word Recovery nor permit anyone else to do so. You may not 
make access to Stellar Phoenix Word Recovery available to others in connection with a service 
bureau, application service provider or similar business nor permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations. 
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Stellar Phoenix Word Recovery and all accompanying software, files, data and materials are 
distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. 
In particular, there is no warranty for the quality of data recovered. You acknowledge that good 
data processing procedure dictates that any program including Stellar Phoenix Word Recovery 
must be thoroughly tested with non-critical data before there is any reliance on it and you hereby 
assume the entire risk of all use of the copies of Stellar Phoenix Word Recovery covered by this 
License. This disclaimer of warranty constitutes an essential part of this License. 

In addition, in no event does Stellar authorize you or anyone else to use Stellar Phoenix Word 
Recovery in applications or systems where its failure to perform can reasonably be expected to 
result in a significant physical injury or in loss of life. Any such use is entirely at your own risk and 
you agree to hold Stellar harmless from any and all claims or losses relating to such unauthorized 
use. 

General 

This License is the complete statement of the agreement between the parties on the subject 
matter and merges and supersedes all other or prior understandings, purchase orders, 
agreements and arrangements. This License shall be governed by the laws of the State of Delhi, 
India. Exclusive jurisdiction and venue for all matters relating to this License shall be in courts and 
for a located in the State of Delhi, India and you consent to such jurisdiction and venue. There are 
no third party beneficiaries of any promises, obligations or representations made by Stellar 
herein. Any waiver by Stellar of any violation of this License by you shall not constitute nor 
contribute to a waiver by Stellar of any other or future violation of the same provision or any other 
provision of this License. 

Copyright ©1995-2009 by Stellar Information Systems Ltd. All rights reserved. 
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Technical Support 
Our Technical Support professionals will give solutions of all your queries related to Stellar 
Products. 

You can either Call Us or Go Online to our support section 
http://stellarinfo.com/esupport/users/kb.php 

Support Helpline 

Monday – Friday [ 24 Hrs. a day ] 

USA (Toll free - Pre Sales Queries)  1-866-554-2512 

USA (Post Sales Queries) 1-315-220-6245 

UK (Europe) +44-207-993-2293 

Germany +49-180-110-105-0051 

Worldwide +91-921-395-5509 

Skype Id stellarsupport 

Email Order orders@stellarinfo.com 

Online Help 
 Chat Live with an Online technician 

 Search in our extensive Knowledge Base 
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 Submit Ticket (If our Knowledge Base does not answer your question) 

 Login and view Ticket Status (If you already have a valid Ticket with you) 

 Download Documents on Product Usage ( For Registered members only, i.e, user with 
login ID. If you are an unregistered user, please visit 
http://stellarinfo.com/esupport/users/login.php to create login ID) 
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About Stellar 
Stellar Information Systems Ltd. is a trusted name in the field of Data Recovery and Data 
Protection Software for more than a decade. 

We provide the widest range of Data Recovery Products. Our range includes Data Recovery 
Software for almost all Operating Systems and File Systems. 

Product line: 

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after 
accidental format, virus problems, software malfunction, file/directory deletion, or even sabotage!. 
More Info >> 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office 
repair tools. More Info >> 

Email Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS 
Outlook Express and MS Exchange useful in instances of data loss due to damages and 
corruption of Email. More Info >> 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to 
ensure complete data protection against hard drive crash. More Info >> 

Data Sanitization 

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical 
drives, System Traces & Internet traces. Once the data have been removed using Stellar Wipe - 
Data File eraser utility, it is beyond recovery limits of any Data Recovery Software or utility. More 
Info >> 

For more information about us, please visit www.stellarinfo.com 

 

 


